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1. PURPOSE

This document is specific to the released software and should contain the 
software name and version in the title, e.g., “Curry 7 Release Notes”. It is 
written for the end user’s benefit, and contains the following information:

2. SUMMARY OF CHANGES SINCE LAST RELEASE

This is an overview of the most significant changes and bug fixes that 
were made to the current software release compared with the last release,
Curry 7.0.11. Important changes with respect to previous versions of Curry
follow at the end of each section.

2.1. Highlights

 Added support for Nihon Kohden V1200 format
 Added support for Stellate Harmonie 7.0 format

For Curry 7.0.11:
 Compatibility with Curry 8 file formats
 Curry 7 now also accepts dongles containing Curry 8 licenses
 Display of intensity values based on rescale intercept/slope parameters in Image 

Data popup information window.
 MATLAB plugins now work without having to edit Windows environment variables
 MATLAB plugins now receive channel labels and trigger events
 Added amplifier configurations for new Quik-Cap Net (32, 64, 128 and 256 channels)
 Added an option to convert recordings into other file formats from within the 

Acquisition module (no Signal Processing license required)
 Added impedance check on positive and negative bipolar channels for Grael 

amplifiers
 Bug fixes

For Curry 7.0.10:
 Option to display a labeled Talairach grid in Image Data orthogonal views
 New version of MATLAB Curry data file reader with event support and file name 

selection
 EEGLAB plugin to read Curry data files (install via EEGLAB's extension manager)
 Event codes and sampling rate are now passed to MATLAB, when using the online 

MATLAB interface
 Improved performance when “out-of-realtime-severity” is low (this mostly affects 

MAGLINK recordings)

For Curry 7.0.9:
 Display butterfly subgroups when montages with gaps are displayed
 New option to apply Montages across channel groups
 Clicking on a transparent object in 3D View now selects the underlying object
 Option to compute 'Cursor Mirrored' and 'Cursor Mirrored Fixed' CDR dipoles
 Support for DICOM JPEG RGB images
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 Support for Brainvoyager .vmr version 4 and 6 format
 Localize list now allows to select and review entries in Show mode
 New Load.m file in Matlab folder that loads dat/dap/rs3 files into MATLAB and 

displays their waveforms

For Curry 7.0.8:
 New “Pretrigger” (and “Auto”) modes for noise estimation that exclude spike onsets
 Support for Grael EEG amplifier
 Support for Compumedics Neuroscan Photic Stimulator device
 Option to create depth (needle) electrodes in Localize Grid Setup
 Support for Electrode, Localize, Point, Landmark label display in Image Data
 New “2D Visibility” parameter for Dipoles, Localize, Points, Landmarks, as well as 

Current, Scan, Leadfields (in Symbol mode) that controls out-of-plane visibility in 
Image Data

 Deselect channels in position plot w/ and w/o combined gradiometers
 Improved support for Nicolet, Nihon-Kohden, and XLTek file format

For Curry 7.0.7:
 Statistics module now available with “Basic Source and Image Processing” license
 Improved file format support for EDF, Nihon-Kohden, XLTek, Nicolet, 4DNI, Elekta, 

BESA, Shimadzu file formats
 Increased number of EEG channel groups to 20 (for invasive recordings)
 Option to use FIR filters
 Option to deselect channels from combined Gradiometer map and from position plot
 Option to display a ruler with time labels and ticks below the waveform and position 

plot display in Maps
 Image Data saved as DICOM files with source results now include result names and 

clipping values
 Names for Kept Results which had been edited (e.g. in 3D View) are used as 

suggestions for filenames and retained through saving and loading these results
 Added support for NuAmps amplifiers for 64-bit Windows operating systems
 Added Hi-Level channel support for Neuvo devices
 Added support for Cedrus Stimtracker device
 Error Reporting tool

For Curry 7.0.6:
 Option to cluster source results while scanning through epochs
 Improved study synchronization with time/frequency and 3D cursor synchronization
 Option to duplicate a study for synchronization
 Option for blocked and overlapping in-place averaging of events
 Statistics can now access individual epochs when “x Epochs” is not checked
 Statistics can now compute consistency tests for only one condition
 Option to detect local peaks in single channels for manual event cursor alignment
 Creation of cortical lamina along with cortical triangle mesh in BEM Geometry for 

improved brain visualization
 New “Use same folder” option for better file selector folder presets
 New database options to load all results and to load a single result by double-clicking
 Improved impedance calculation for SynampsRT/2 and NuAmps
 Added support for Cedrus StimTracker
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 Added support for ProFusion PSG3 studies
 Added support for video in ProFusion studies
 ProFusion readers don't interfere with local ProFusion installation(s) any more
 Improved touchscreen support (pinch-to-zoom)

For Curry 7.0.5:
 Option to perform and display channelwise STFFT/wavelet analysis
 Option for weighted artifact subtraction (linear detrending) added (improves fMRI 

artifact reduction during acquisition in certain cases)
 Option to load and save SCAN event file format (extension .ev2)
 Option to merge event information from STIM-file
 Option to specify any channel as a (binary) “Trigger” channel on page one of Data 

Parameters. Configuration file “Trigger.cfg” controls how the bits in a trigger channel 
are interpreted

 In Image Data, electrodes are now colored according to their voltages if a color scale
is selected

 Option to export cursor location to Localize by CTRL-clicking in an Image Data view
 Option to export Scan results as SPM-format files
 Improved update rate of Impedance Test when using monopolar channels only 

(applies to Synamps2/RT)
 Enabled response bits on NuAmps trigger channel
 New 'Plausibility Check' option in Acquisition Digitizer Dialog
 Option to add comments to acquired file before or during recording
 Option in the Window menu to synchronize display pages and time cursors across 

(matching) studies
 Option to download tutorial data files via the Help menu
 New “Windows 8” visual style with higher contrast for flat UI elements available via 

Edit > Options. This style is automatically selected under Windows 8

For Curry 7.0.4:
 New digitizer hardware supported: NDI Polaris, Polhemus FasTrak III
 Option to enable Voltage Output on Synamps2/RT High-Level connector
 Option to rotate and scale electrodes in the Sensor Placement dialog
 Option to apply a Constant Baseline Correction during acquisition
 Option to apply a Linear Derivation File during acquisition
 New amplifier configuration options
 Improved Synamps2/RT impedance test
 Improved video synchronization
 Frame-by-frame video navigation
 Added “trigger” channel type
 Montages may span over multiple groups
 File name and folder suggestion when saving data files
 File format and options are now remembered for next data file save
 Source results now include event name or data file name in their description
 CDR dipoles and coherence now include type in their description
 Option to use MATLAB to compute lead fields
 Option to export Scan results to Excel and MATLAB
 Improved macro usability
 Improved MATLAB support
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 Curry now silently checks for updates every week
 Updated Manuals

For Curry 7.0.3:
 Digitizer module with Polhemus Fastrak support
 Video module for recording synchronized EEG and video
 “Auto-detect bipolar channels” functionality for NuAmps amplifiers
 White list to identify bipolar (non-EEG) channels
 Nicolet file format reader (requires Nicolet reader or better installation)
 EDF / EDF+ file export
 Neuroscan EEG file export
 Simultaneous time & frequency display
 Scan data forward/backward with adjustable stepsize
 Ripple and fast ripple filter frequencies added
 Epoch labels for saved / averaged events added
 Save channel as wavefile
 Modify selected event types
 SubSampleCorrection functionality for artifact correction implemented
 Multiple epoch types for averaging implemented
 Five sequences for template matching implemented
 Contour lines and maps in frequency mode enabled
 Enabled colored electrodes (contour lines and maps off)
 Time range and Ellipsoid display mode toolbar buttons work faster
 Electrode label names are now displayed in image data tooltips
 Intensity differences between left and right hemisphere are now shown in image data

tooltips
 When using the mouse wheel in the Segmentation Result display, segmentation 

results update to reflect the changed threshold
 Standard skin, skull, and brain are now always available for display
 Points are now offered for 3D display even if they are not loaded yet
 Option to only show coherence arrows for certain regions only. Extensive coherence 

region output
 New dipole color type “Auto” which switches between “Time” and “Dipole index” 

depending on dipole type and number of samples
 Improved workflow for “Adjust Sensor Positions” in Localize
 Automatic 10-20 system setup creates all 160 10-5 system positions
 Macro support for Localize interactions in 3D View
 Parameter panel switches are now recorded to macro
 Improved study selection when running macro on database entries
 Updated Manuals

For Curry 7.0.2:
 Updated Manuals
 Noise estimation: Auto mode added and made the default (defaults to Percentile 20 

for continuous files, else Pretrigger is used)
 Baseline correction: Constant Pretrigger added
 Display insignificant statistics result time ranges using gray backdrops
 Option to merge several dipole results into one as an alternative to “Keep Results”
 Added Grael support
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 Acquisition now supports PCA filtering (from file)
 Acquisition now supports MATLAB plugins
 Acquisition now supports STFFT display
 Option to review from recorded file during acquisition

For Curry 7.0:
 Acquisition module
 Transforms for artifact detection and reduction 
 Sensor and source coherence
 Frequency domain source analysis 
 ICA-based dipole fits
 PCA/ICA-based current density analysis
 eLORETA current density method
 ECoG grid placement planning
 Fiber orientation visualization based on DTI FA images
 Statistics module
 MATLAB APIs
 Automation and batch processing

2.2. User Interface

 Fixed a bug where some non-ASCII characters were not displayed correctly in 
Output window

For Curry 7.0.11:
 Option to reset window layout when Curry finishes (but not immediately)
 Content menu is now displayed for enlarged Output window
 Bug fixes

For Curry 7.0.10:
 Prevent detaching the main menu bar
 Main window now restores size and position (from previous run)
 File menu now includes an option to load last used parameters
 Check for Updates window now closes immediately when user cancels
 Improved diagnostic feedback in Check for Updates window if no update is available
 Program shows a warning if double-clicked file cannot be opened
 Bug Fixes

For Curry 7.0.9:
 Changed visual style of all tree-based display to “full row selection”
 Selecting an image data folder works now for any order of operation
 Removing files from an open study now keeps the currently selected view tab
 Removed "dock menu" button from control bar caption (Windows 8.style)

For Curry 7.0.8:
 Improved performance of scrollbar for files with many events
 Set selection to first selected manual event after changing type (0-9)
 Scroll through data pages using the mousewheel (context menu option)
 Use Control & Alt & mouse drag to mark a bad block.
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 Changed “erase” text to “delete” when deleting files.
 Unique filename suggestion when saving hardcopy files.

For Curry 7.0.7:
 When copying text from a grid (such as Localize, BEM, etc.), notepad-compatible line

breaks are now created.
 Video compressor selection if now retained for next .avi file save.
 When trying to create a file whose name contains forbidden characters these are 

now replaced.
 Changed “SNR” to “Max SNR” in Noise Estimation panel.
 Applying “All Files (*.*)” filter now also displays files without any extension.
 When closing studies and prompting for unsaved results, study name is now 

mentioned.
 Bug Fixes.

For Curry 7.0.6:
 New “Use same folder” option for better file selector folder presets.
 Expanding rollups and "Advanced" buttons scrolls dialog page "to top".
 Channel selection window opens in currently selected channel group.
 Ask for overwrite popup dialog text now conforms with Microsoft conventions.
 “Open File Location” options now select (highlight) the file name.
 Renamed “3D View Safe Mode” to “3D View Compatibility Mode” in title bar.
 Ensure view gets keyboard focus when studies are opened without database.
 When pressing the Ctrl key while starting an “eternal” movie or rotation, replay 

doesn’t stop when Curry loses the focus (use Esc key to stop).
 LDR, Derive, Integrate, Rectify moved to Baseline section.
 Bug fixes

For Curry 7.0.5:
 New “Windows 8” visual style with higher contrast for flat UI elements available via 

Edit > Options. This style is automatically selected under Windows 8
 Option in the Window menu to synchronize display pages and time cursors across 

studies
 Option to download tutorial data files via the Help menu
 Changed “overwrite” notification text for Save Movie As dialog 
 Updating views now addresses the correct childframe, even if it has not the focus
 Bug fixes

For Curry 7.0.4:
 Modify event type extended for bad blocks
 Show event list with valid events only (wrt bad blocks and conditions)
 Always display event type on top of waveform-display
 Disable Show Timedomain for loaded spectral data
 Save all three time-cursors (macro and parameters)
 Kept waveforms from position plot keep their colors
 Keep time-cursor distance when scrolling through the data
 Selected artifact sequence tab saved in parameters
 Added 'Help' button to Conditions dialog
 Hardcopy image file format is now remembered between calls
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 Increased size of small Image Data cross-sections for the “All” display mode
 Maximum number of open studies is now dynamically detected
 Removed driver install entries from start menu as this is now offered in Acquisition
 Option to specify Database, Parameter heading, Output font via a Fonts.txt file
 Bug fixes

For Curry 7.0.3:
 Set pre- and post-latencies for R5 events automatically.
 Pre-trigger baseline correction for in-place averaged events.
 Sum of all valid events in valid event display.
 Checkbox for other channels included in artifact reduction.
 Reset button for individual channel color restores actual color.
 Waveboard with vertical 0.0 ms line (dotted).
 Reset all parameters (factory defaults) from macro.
 Save all montage names to study parameters.
 Average all event groups / revert to continuous improved (toggle button).
 First channel (vertical scrollbar) -> study parameters.
 Zoom and cursors kept when going through the eventlist / deleting events / averaging

in-place.
 Artifact PCA (show) displays five leading components.
 Larger font for time-cursor, collision detection improved.
 Don't display others with PCA/ICA filtering.
 Update event-list scan-button after filter changes.
 Move cursor in waveboard (event analyses) to next / previous event.
 Keyboard selection (left/right/return) of events in waveboard.
 Keep average of selected time/frequency range.
 Page up/down enabled for concatenated continuous files.
 Pensize, cursorlinewidth, and plus-is-up kept for in-place-averages.
 Modify first displayed channel Alt & mousewheel.
 Frequency tick distances saved / restored.
 New checkbox: Show Other Channels.
 Butterfly plot includes others if selected.
 Delete select event directly from event list.
 Longer label-length possible (20->40).
 Changed right hand border for amplitude values.
 Scan data movie implemented.
 Epoch label shown for single group average.
 Switched the positions of the “Time Range Display Mode” and the “Ellipsoid Display 

Mode” toolbar buttons.
 Added a “Play after save” checkbox to the save avi file selection.
 Added an option in the Troubleshooting section of Edit > Options to limit the frame 

rate for viewing movies within Curry (via the “Play Movie” toolbar button).
 Changed the number of color transitions in the Colors section of Edit > Options from 

7 to 8.
 Added explanatory tooltips to more Edit > Options parameters. 
 Several popup windows with questions now have custom button texts instead of the 

previously used Yes/No/Yes to All etc which was not always appropriate.
 Changed the Red..Yellow..Green colorscale to Green..Yellow..Red. This colorscale is 

suggested for impedance display, unless user is color-blind.
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 Changed the Red..Yellow colorscale to Yellow..Red.
 Changed the Green..Yellow colorscale to Yellow..Green.
 Changed the Blue..Cyan colorscale to Cyan..Blue.
 Added a rainbow color scale. This color scale is suggested for PET/SPECT images.
 Added tabs "Acq, FD", "Acq, FD H", and "Acq, FD, Maps, 3D" to Curry X versions.
 “Enlarge” buttons will be hidden even after rapid mouse movements.
 Replaced the macro toolbar icon for “loop over files” with an icon that shows a 

datafile symbol and a play macro symbol.
 Moved the macro “Playback options” heading into the macro toolbar.  
 Rollup- / parameter dialog switching can now be recorded for macro replay.
 The verbosity submenu of the Output context menu now shows the same options as 

the Edit > Options dialog.
 Bug fixes

For Curry 7.0.2:
 Bad Blocks appear as gray areas in the scrollbar
 Hide scrollbar in frequency mode
 Montage editor is now also available in Curry 7 S and Curry 7 SB

For Curry 7.0:
 Navigation area comprising workflow, database, events, display parameters
 Macro-enabled workflow sidebar
 Options window
 Adjustable hardcopy / movie size
 Maximize icons for data displays and selection grids
 Detachable parameter dialogs
 Extensive Online (F1) Help
 Additional color scales

2.3. Database

 Fixed a bug that prevented displaying files correctly after deleting an experiment
 Fixed context menu item (displayed “Study” instead of “Subject”)
 Fixed display update when dragging between tree items
 Fixed a bug that prevented importing MDA files containing multi-line comments

For Curry 7.0.11:
 Display support for Curry 8 macros that don’t automatically run when opening a study
 Database ASCII export files (.mda) now contain parameter inheritance 
 Context menu for Subjects now also works for read-only databases
 Fixed a resizeable user interface for Subjects’ and Studies’ properties
 The status of image data folders containing a dot (.) is now displayed correctly

For Curry 7.0.10:
 Bug Fixes

For Curry 7.0.9:
 Bug Fixes
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For Curry 7.0.8:
 Changed icon for read-only database archives to grayscale.
 Bug Fixes

For Curry 7.0.7:
 Prevent opening studies per double-click if current product type does not support it.
 Present a “no access” icon if a database connection cannot be established.
 Bug Fixes.

For Curry 7.0.6:
 Added "Insert Result File" to database menus. 
 Double-clicking a result stored in the database now loads the result.
 New context menu option to load all results in a study.
 “Split Recordings” are now displayed with the correct icon.
 If adding entries to a (read-only) database fails, there is now an error message.
 Improved detection of image data files if .imd file is entered in database.
 New padlock icon indicates a locked study (during in-place averaging).
 New toned-down parameter icon indicates that a functional data file is reusing Curry 

Parameters from a file in the same study.
 Pressing the "return" key now modifies database properties.
 Speedup when adding/removing files to/from an open study.
 Bug fixes

For Curry 7.0.5:
 Added sampling rate to “file” tooltip
 When opening study, missing files will be removed from list and user will be notified
 Bug fixes

For Curry 7.0.4:
 Resorting files in study can now be done without pressing “Ctrl” key
 Prevent dropping studies in an “Unfiled” study
 Added context menu item to edit Macro (and Study Parameter) files.
 Font of database tree is now consistent to rest of Curry UI
 Prompts now for saving modifications (of open studies) when closing / switching 

database
 Bug fixes

For Curry 7.0.3:
 Display gauge when reading large databases.
 Auto-scroll when dragging items.
 Added "Open File Location" for database root item.

For Curry 7.0.2:
 Bug Fixes

For Curry 7.0:
 Toolbar
 Drag-and-drop support
 Nested folder support
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 Experiment support
 Parameter and data file inheritance 
 Relocation options (relative paths, change paths)

2.4. EEG and MEG Data Import

 EGI MFF reader now reads "other" channels from second data file, if available
 XLTek reader now supports header versions 7 and 8
 Added support for Nihon Kohden V1200 format
 Non-epoched files now may contain both "start time” and “trigger offset"
 XLTEK: classify DC1..6 as Others and X1..18 as EEG
 EGI MFF reader now imports landmarks from coordinate files
 Micomed reader now detects files containing "open" channels
 Brainvision events reader now reads descriptions that don't differentiate between 

event types
 Added support for Stellate Harmonie 7.0 format
 UTC “start of session” time is now converted to local time
 Fixed a bug in EDF inport when caching files that contain multiple sampling rates
 Gap events are not inserted when segments in XLTek files are contiguous
 Fixed precision problems when upsampling Compumedics Sleep and EEG 3 files 

during caching
 Fixed a crash in the Functional Data Wizard that occurred when deselecting all 

electrodes and gradiometers were available
 Fixed a bug in EDF reader that prevented loading files larger than 2 GB
 Fixed a bug in ProFusion PSG 3 reader that prevented loading files containing EMG 

channels
 Fixed a bug when writing parameter files containing both multiple groups and 

reference channels
 Fixed a bug in autodetection that recognized EDF files with many channels as "text" 

files

For Curry 7.0.11:
 Added support for ANT Xensor files (.elc)
 Channel labels obtained from EGI MFF format can now be remapped to 10-10 labels
 “Other” channels from Compumedics Sleep studies are now down-sampled to 

highest EEG channel rate
 EDF importer now correctly handles individual sampling rates per channel
 CTF event reader now handles empty event groups correctly
 CTF event reader now handles multiple epochs correctly
 BrainVision reader now handles files correctly that were exported by EEGLAB
 Neuroscan exporters now use “Scan” defaults for filter settings
 Prevent rounding errors when exporting events for EDF+ files with high sampling rate
 Bug fixes

For Curry 7.0.10:
 New version of MATLAB Curry data file reader “LoadCurryDataFile.m” with event 

support and file name selection (in Matlab folder below Curry 7 install folder) 
 EEGLAB plugin to read Curry data files (install via EEGLAB's extension manager)
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 Updated Fifflabels.txt file reflecting newest generation of Elekta caps (previous 
version still available but must be renamed to Fifflabels.txt to be used)

 Suppress "access denied" message when auto-detecting ProFusion PSG studies
 Nicolet 4 reader displays generic event text instead of "user defined"
 Added check for a local version of Neuromag's "EEG label replacement" file
 EDF reader now converts labels like "FP1, EEG" correctly into “FP1” (not “EEG”)
 EGI reader now considers “label” and “code” tags in event file and consider 

EventMap.txt
 Added “averaged” data support for EGI MFF reader
 Planar gradiometer information is now stored correctly in parameter files
 Removed “max. 500 events” limitation of Profusion EEG 4 reader
 Sensor unit is now applied correctly when writing parameter files
 Session defaults now have an option to invert polarity of XLTEK channels
 Scaling factors are now applied for all Brainvision files, not only integer type
 Trailing headshape points are now ignored when computing SVD transformation for 

sensors
 Auto-detection checks if data file and parameter file match (extension wise)
 Bug Fixes

For Curry 7.0.9:
 Increased max. allowed sampling frequency for Micromed files to 2048 Hz
 Fixed a bug that led to a crash when reading certain Neuromag files
 Added keyboard shortcuts “0” - “9” to switch to higher channel groups in Data 

Parameters window
 Data Parameters window now preserves epoch-, amplifier-, and impedance 

information
 Bug Fixes

For Curry 7.0.8:
 Montages from ProFusion studies are now available for display.
 LM and RM are now recognized as alternatives to M1 and M2.
 LArm, RArm, LLeg, RLeg, Back, Trigger, TRG, TR are now detected as Other 

channels.
 Improved support for Nihon-Kohden files (scaling factors and recording “session” UI)
 Neuromag MEG labels are not truncated any more.
 Switching the “sensor source” in the wizard now preserves the disabled sensors.
 Added support for XLTEK headbox types 17 and 21.
 Added support for XLTEK "Notes" (*.ent) file for reading channel labels. 
 Bug Fixes

For Curry 7.0.7:
 Increased number of EEG channel groups to 20 (for invasive recordings).
 Added support for reading Nihon-Kohden events and wall clock.
 Added support for XLTek headbox type “17”.
 Polarity is now inverted when reading XLTek files.
 Added support for Nicolet Reader / Viewer version 4.
 3rd party Yokogawa reader DLL is now optional - Curry runs without it.
 Added option to strip leading “MEG” from Neuromag channel labels.
 Added support for “initial skip” when reading Neuromag files.
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 Auto-created Neuromag “headshape” file now also contains HPI coils.
 Functional Data import wizard now reuses parameter files even if the number of 

samples differs.
 Adjusted Magnes import filter to accept files like “50s_e,....”.
 BESA .elp reader now treats “E1, E2,...” as labels, not numbers.
 Added support for reading Shimadzu NIRS files (experimental).
 Event reader now skips empty rows in .ev2 files (instead of stop reading).
 Bug fixes

For Curry 7.0.6:
 Support for “TTL” trigger channels.
 New "trigger" logic for negative (absolute) flanks: generated type is now "target" 

sample (e.g. 5 -> 4 generates “n4”, not “n5”).
 "Trigger channel" defaults are now: "absolute mode", "react on both flanks".
 Added support for reading "raw double" files.
 Added support for reading ProFusion PSG3 file format.
 Wizard now switches to "leave positions as they are" when reading *.pom files.
 Wizard: Lowest supported sample frequency is now 1 Hz.
 Wizard: "Load digitizer file" dialogs now initially start in functional data file's folder.
 Wizard will now prompt to overwrite obsolete *.cef files if user has modified “Trigger” 

channel settings.
 Added "parameterized" icon for wizard (to distinguish auto-detected files).
 Added "default channels" and "auto-save *.cef" to trigger configuration file.
 ASCII reader: "comma" is now a valid decimal separator
 ProFusion PSG2, EEG3, and EEG4 readers now don't interfere with local ProFusion 

installation(s) any more.
 BDF reader: added optional "sloppy" reading ("off" by default).
 BrainVision: channel "resolution" is now applied for integer formats.
 Neuromag reader now discards (0, 0, 0) when counting "valid" electrode positions.
 Neuromag reader now compensates "initial skip" when reading events.
 Neuroscan reader now reads events generated by "manual hotkeys" in continuous 

data files.
 Neuromag reader now refuses to load "SmartShield" data (can be re-enabled by 

editing SessionDefaults.cfg).
 Neuromag reader now extracts "start of recording" (incl. "first sample" offset)
 Neuromag reader: increased performance for reading electrode positions.
 Nicolet reader now supports channel interpolation.
 Nihon Kohen *.21E (label) reader now also imports channels found in [REFERENCE]

section.
 Stellate reader now supports per-channel sampling rate.
 Bug fixes

For Curry 7.0.5:
 3D preview selection is now correctly updated when user changes channel type from

"other" to “EEG” group
 Option to specify any channel as a (binary) “Trigger” channel on page one of Data 

Parameters. Configuration file “Trigger.cfg” controls how the bits in a trigger channel 
are interpreted.
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 Improved group study parameterization by reusing any data file's parameters, not 
only the first

 Brainvision event types are now mapped to annotations
 For 4DNI and CTF MEG formats, the channel type of MEG channels cannot be 

changed to “other” or “EEG” group any more. Such channels can still be deselected 
in Functional Data.

 Neuromag channels of type “STIM” are not scaled to "µV" any more so that they can 
be used as trigger channels

 When exporting data, the start sample is now added to "start of session" time
 "Disabled" channels are now skipped correctly on data import
 Bug fixes

For Curry 7.0.4:
 When fitting a sphere to sensors, (0,0,0) and very large coordinates are now ignored
 Parameterization feedback dialog for digitizer files is now easier to understand
 Support for BTi data exported to CD (numbers-only filenames)
 Added “left/right periauricular point” to list of recognized landmark labels
 Improved “raw float” autodetection
 Legacy EGI reader now supports events
 XLTek-reader: “table of contents” file (*.etc) file is now optional
 Sensor positions on wizard's “general” page are now read-only
 Added (faked) landmarks for 128- and 256-channel EGI caps
 Bug fixes

For Curry 7.0.3:
 Nicolet file format reader (requires Nicolet reader or better installation).
 EDF / EDF+ file export.
 Neuroscan EEG file export.
 Support for Yokogawa .con files.
 Yokogawa reader now assigns (zero based) channel index for empty labels.
 PAN landmarks are correctly extracted from Yokogawa files.
 Support for Micromed 8 and 32 bit files.
 Support for (binary) BrainVision .eeg files.
 Neuromag EEG labels can be “remapped” to 10-20 labels.
 BESA format .elp files can be used as anatomical landmarks.
 A folder containing libraries for reading ProFusion format files is now created by the 

installer. This folder contains a registration script. Only register and use these 
libraries if ProFusion proper is not installed on that specific computer.

 Label-matching locations CB1 and CB2 are now equal to I1 and I2; added location 
CBz which co-localizes with Iz.

 Label-matching locations M1 and M2 are now located at the actual mastoid positions.
When using a cap with drop-leads, make sure M1 and M2 are correctly localized.

 White-list for labels that identify channels in the “Others” group (bipolar channels): 
VEO, VEOL/U, VEO+/-, HEO…, EKG…, ECG…, X1..9, ROC, LOC, IO1/2, SO1/2, 
LO1/2.

 When identifying labels for label-matching, first, full matches with the built-in table are
sought, then partial matches where the actual label contains a label in the built-in 
table as a sub-string.
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 Channel labels are now made unique during import to prevent ambiguos macro 
recording / replay.

 Raw digitizer files be “re-parameterized” in the wizard.
 Display coupled magnetometers as "sensors / channels" in wizard.
 Automatically separate planar gradiometers in "longitude" / "lattitude" groups.
 Bug fixes

For Curry 7.0.2:
 In the import wizard, enabled the use of an additional “reference” channel
 Neuroscan *.cnt reader now supports files larger than 2 GB
 Neuromag reader now imports events
 “Gap events” (between data segments) have now the type “br0” and “br1”

For Curry 7.0:
 New EEG and MEG data import wizard
 Continuous support for changed and new file formats

2.5. Signal Processing

 Peak files are now written UTF-8 encoded
 Fixed an issue with removal of the last sample of bad blocks
 Fixed an issue with baseline-correction foe multiple epochs ('Use All' mode)
 Improved synchronization between video replay and time cursor position
 Scrollbar now only shows valid template events
 Fixed an issue where montages would not display channels from the Other device 

group
 Fixed a problem where “Show this channel only” displayed the wrong channel
 Show info-box after merging event list with behavioral data from Stim2

For Curry 7.0.11:
 Assign same epoch type for all back-to-back epochs and use "back-to-back" as label
 Allow longer event annotation texts
 MATLAB plugins now receive channel labels and trigger events
 Added support for old Stim2 behavioral data format
 Frequency Domain txt export now contains channel labels and frequency bin 

information
 Interpolating channels with interpolated channels now works correctly
 Event annotations are now drawn non-overlapping (if possible)
 Adjusted “page advance” when scrolling with the mouse wheel
 Added macro support for exporting channel waveforms as wave file
 Added more robust checks for correct time-range during macro replay
 Threshold events are now correctly reset before data is scanned
 Scanned epochs are now correctly reset when epoch type is switched
 Bug fixes

For Curry 7.0.10:
 Allow PCA-filtering when averaging events in-place or exporting them
 Added option “Reset All Channels” to Functional Data menu
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 Added a check for sufficient aliasing filters when saving downsampled data; set 
sufficient aliasing filters on request

 Move whole timerange by pressing Ctrl + Alt + Left/Right cursor keys
 Rulers in Waveboard have been replaced by scales
 Improved performance in study with video, when video window is closed
 Display additional timestamps at 0.2s lines for pagesizes smaller or equal than 2 sec
 Added visual feedback when setting cursors via Ctrl + click & drag in frequency 

domain
 Bug Fixes

For Curry 7.0.9:
 Enable ASCII-text export of frequency domain data (amplitude or power spectra)
 Fixed individual filter settings of other channels
 Fixed actual time-cursor in synchronized studies
 Fixed crash when keeping reconstruction results from scanning through epochs and 

displaying epoch statistics
 Fixed an issue when scanning for multiple templates (e.g. Best3)
 Fixed template matching with <All> channels / save parameters
 Fixed limited cursor range in frequency-domain, removed Reset in channel color
 Fixed global covariance artifact reduction when zoomed in
 Fixed next/previous event and event selection from timeline-ticks and waveboard
 Fixed export of selected epochs
 Fixes limited cursor range in frequency-domain
 Removed Reset in individual channel color
 Consider gain in SNR due to averaging (reduced noise -> confidence ellipsoids)
 Ask whether to save changed data file properties on save study parameters
 When saving changed events on save study parameters, don't present an event file 

dialog any more
 Added default colors for EEG groups with index > 8
 Display butterfly subgroups when montages with gaps are displayed
 Added an option to apply Montages across groups
 Added new montage MEG Elekta 8 Sectors Referential 
 Bug Fixes

For Curry 7.0.8:
 Save artifacts to disk if out of memory during scan.
 Enable back-to-back epochs for short files < 60s.
 Keep event list after back-to-back epoching and averaging.
 Do not compute noise-estimation during artifact scan.
 When saving averages, the preset is now to save the full time range.
 “Show information" dialog now displays "MB" for larger files.
 “Show information" dialog displays duration in hours and minutes for larger recording 

times.
 Replaced push-buttons in "Event Annotations" dialog with static text.
 Enable reverting concatenation for epoched files (with study defaults).
 Show channel labels in tooltips on mouse move.
 Pre-trigger or auto timerange from start to -50ms instead of 0ms if start < -490ms.
 Interpolate EEG-potentials for electrodes from external pom-file.
 User defined noise-level and computed noise-levels treated separately.
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 Minimum amplitude threshold for template matching lowered from 30% to 20% (max. 
increased from 333% to 500%).

 Export peaks: fixed labels of montage channels.
 Multi-threading for FFT-filters enabled.
 Bug Fixes

For Curry 7.0.7:
 Option to create a prototype *.ldr file that contains a unity matrix.
 Option to use FIR filters.
 Option to align stimulus events with Cedrus Stimtracker Mic, Aud and Pho events.
 Option to taper artifact reduced data segments.
 New example MATLAB file that creates a butterfly plot of channel waveforms.
 Increase number of event conditions to 10.
 Improved noise estimation for single epochs.
 Improved Merging of Behavioural Data from Stim2 dat files.
  “Save Data” dialogs now memorize sampling rate and all “Add to Database” options.
 Channel Selection control does not enable <All> mode any more for single channel 

data files.
 Bug fixes

For Curry 7.0.6:
 Option to keep (accumulate) source results while scanning through epochs. 
 Option to detect local peaks in single channels for manual event cursor alignment. 
 Added a longitudinal referential montage for Yokogawa MEGs.
 In the FD, Maps display, maps now use up less space.
 Added support for displaying video in ProFusion studies
 In horizontal scrollbar use Ctrl + doubleclick to jump to data page/epoch
 Show event list when there is no horizontal scrollbar
 Added "Save Area"  option to “save” dialogs.
 Hide tooltip if data block was not read successfully.
 Added show and save minimum / maximum peaks for MGFP.
 Added context menu for event list:

show event-lengths / differences, show enumerators.
 Added 10 custom frequency bands.
 Improved compatibility for Curry 6 parameter files for concatenated epochs.
 Improved handling of epoched and back-2-back splitted files.
 Improved memory handling for beamformer scans.
 Center event if it's not completely on current display page.
 Change event annotations when manual events are modified.
 Improved PCA and ICA artifact reduction and display of components (group-wise).
 Modified LDR file handling, LDR is now applied before baseline correction.
 Event list is now deleted after reverting “concatenate”.
 Changing individual channel filter settings resets 'Scan' button (artifact reduction).
 Added in-place averaging of events with definable block- and step-size.
 Bug fixes

For Curry 7.0.5:
 Repaint if template matching switched off
 Refractory period disabled for bad block detection
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 UI logic for epoch selection improved (voltage/frequency checkboxes and channel 
selection)

 Repaints added when changing rejection parameters
 Output averaged MGFP per device if data are averaged
 Disable Select All Epochs if already selected
 Overwrite epochinfo during epoch scan only
 Display averaged channel and MGFP values if time or frequency range averaged
 Increments epoch statistics: 0.1 -> 1.0
 Avoid collision of event type info and min/max voltages
 Separate noise time-ranges for noise estimation and event/epoch statistics
 Noise timerange start/end added for event/epoch statistics
 FSP Off-button for viewing waveboard added
 StopSample set when loading parameters
 Warning removed if artifact file does not yet exist
 Weighting for artifact subtraction (linear detrending) added
 Detrending (artifact reduction) for even number of averages only
 Zero line in waveboard improved
 Artifacts averaging (for All) improved
 Save show sensors (map option) to parameters
 Labels for STFFT channels added
 Display of channelwise STFFT improved
 Do not show mixed waveforms from time and frequency domain in waveboard
 Reset bad blocks updates manually set bad block correction and workflow
 No negative peaks in frequency domain displayed
 Clipping of waveforms in waveboard improved
 Font for event type and vertical time-lines modified
 Event type of artifact sequences set on initialization
 Added event type 0 for change event type
 Set 'Include Others' and 'Use Unfiltered Data' automatically for event type R5
 Added timerange selection by dragging with Ctrl-key pressed
 Baseline correction options shown as radio buttons
 Option to close parent study when saving a file and opening it as a new study is 

initiated by macro, in order to keep number of open studies low
 "Last used" parameters are not saved in "averaged" mode any more
 Don't draw event bars (duration from event file) for deselected events
 Modified default annotations
 Added "Advanced" button for Functional Data "Options"
 Noise estimation: disable "Get" button for non-timerange modes
 Added tooltip for "Get" buttons.
 Added "peaks" file dialog
 Added "Merge Behavioral Data" button to Event List and corresponding workflow 

item
 Added progress bar when opening studies containing multiple data files
 Bug fixes

For Curry 7.0.4:
 Frame-by-frame video navigation
 Video in concatenated files
 Color events in scrollbar
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 Added <All> token to Conditions dialog
 Added 'Help' button to Conditions dialog
 Manual event class implemented
 Linear derivation implemented
 Concatenate selected epochs only
 Don't delete artifact file after revert to continuous
 Minimum pagesize warning when scanning artifacts
 Scan only selected epochs (first, interleave, last) for SNR and Noise
 Support for epoched data with events
 Use All (overlay) for frequency domain data
 Merging of MEG and EEG from two different data files
 Realign template events to maximum MGFP (in-place-average or export)
 Artifact reduction even if there is overlap with bad blocks
 Colored events in scrollbar
 Added <All> token to Conditions dialog
 File name and folder suggestion when saving data files
 File format and options are now remembered for next data file save
 Frame-by-frame video navigation
 Video in concatenated files
 Bug fixes

For Curry 7.0.3:
 Simultaneous time & frequency display.
 Scan data forward/backward with adjustable stepsize.
 Ripple and fast ripple filter frequencies added.
 Epoch labels for saved / averaged events added.
 Save channel as wavefile.
 Modify selected event types.
 SubSampleCorrection functionality for artifact correction implemented.
 Multiple epoch types for averaging implemented.
 Five sequences for template matching implemented.
 Don't forward data for post-processing during video-replay
 Lower threshold for template matching amplitude 50 -> 30%.
 Scan epoch voltages without other channels (when All is selected).
 Single channel -> reference off.
 Reference channel(s) from old parameter files -> CAR for EEG, NONE for MEG.
 Added Elekta (Neuromag) MEG-specific referential montage for channel array 

subsampling .
 When saving a channel as a wave file (.wav), it is now possible to choose whether 

the file shall be replayed after saving, and if replay speed should be increased by a 
factor of 10 (useful for listening to EEG).

 Scan templates and artifacts ignore breaks and bad blocks.
 Save artifacts to disk if > 100MB
 Ctrl + click now deselects all other groups in the modality UI.
 Channel selector: improved handling of "others" channels.
 Bug fixes

For Curry 7.0.2:
 Baseline correction: Constant Pretrigger added
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 Reset all manually set bad blocks
 Noise estimation: Auto mode added (defaults to Percentile 20 for continuous files, 

else Pretrigger is used)
 All and Global in artifact reduction can be set before scanning the data
 Covariance artifact reduction for template matching
 Refractory period ‘0’: pre + post
 Save events from all selected event groups
 Save events from concatenated files
 Number of valid events in event counter display
 Two digits for SNRs in waveboard display
 Bug fixes

For Curry 7.0:
 Transforms for artifact detection and reduction
 Selective averaging of epoched data or events
 Epoch overlay mode  
 Waveboard  
 Frequency Domain: new filters, display modes  
 Wavelets  
 MATLAB plugin support for signal processing

2.6. Maps

 None

For Curry 7.0.11:
 For frequency domain statistics display, show significant segments as white 

background even if significance is only given for real or imaginary part
 Added channel coherence csv export
 Sphere parameters are now correctly set during macro recording / replay
 Bug fixes

For Curry 7.0.10:
 Display kept waveform in a darker color
 When displaying statistics consistency test results in “butterfly plot” mode, 

background remains white if at least one condition showed significance
 UI for fitted sphere values is now read-only (not disabled)
 Bug Fixes

For Curry 7.0.9:
 Disable channel deselection by left mouse click in PCA-/ICA-plot

For Curry 7.0.8:
 Deselect channels in position plot w/ and w/o combined gradiometers.
 Min-max scaling of waveforms (dipole strength) changed to 0-max (butterfly mode).
 Bug Fixes

For Curry 7.0.7:
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 Option to display a ruler with time labels and ticks below the waveform and position 
plot display. 

 Option to overlay waveforms in Position Plot.
 Option to deselect channels from combined Gradiometer map and from Position Plot.
 Bug fixes

For Curry 7.0.6:
 CDR strength display is now always available and shows the maximum strength per 

sample, if CDR dipoles are unavailable.
 Bug fixes

For Curry 7.0.5:
 Remove sensor coherence results if coherence is deselected in 2D View
 Disabled deselection of channels in statistics mode

For Curry 7.0.4:
 Modify contour line increment by mouse wheel only when mouse over contours
 Bug fixes

For Curry 7.0.3:
 Contour lines and maps in frequency mode enabled
 Display normalized time or frequency maps in 2DView/Maps
 Contour lines (MouseOverSensor) with multiple EEG devices fixed
 2D View / Maps tooltip-units for frequency & power fixed
 Enabled colored electrodes (contour lines and maps off): Amplitude-colored 

electrodes with line color from device color
 Option to display deviations (goodness-of-fit) as a function of time for CDRs
 Bug Fixes

For Curry 7.0.2:
 Headshapes are now displayed together with “Maps”
 Improved display of statistics result labels 
 Improved display of insignificant statistics result time ranges using gray backdrops
 Bug Fixes

For Curry 7.0:
 Sensor Coherence
 Voltage and field maps (in addition to contour lines)
 Laplacian maps
 Statistics result display
 Improved dipole result display (ellipsoid ratio, Chi², simulated dipoles)

2.7. Source Reconstruction

 None

For Curry 7.0.11:
 Bug fixes

For Curry 7.0.10:
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 Improved scaling of standard surfaces in one-shell sphere and BEM case
 Improved coherence MATLAB interface including example m-files
 Initial “2D Visibility” of 5mm for scan and current density results; initial symbol size of 

10mm
 Bug Fixes

For Curry 7.0.9:
 Fixed maximum number of dipoles (10)
 Option to compute 'Cursor Mirrored' and 'Cursor Mirrored Fixed' CDR dipoles
 Don't compute deviation for SNR data in dipole simulation case any more
 Fixed rereferencing bug for multiple groups and reference other than CAR

For Curry 7.0.8:
 Improved field-of-view for MATLAB mesh results preview
 Allow keeping results without previous scan of epochs
 Changed progress bar text for scans from “dip.” to “dipole”
 Bug Fixes

For Curry 7.0.7:
 Output of FWHM-clipped CDR volume for single-latency fits
 Output of percentage of FWHM-clipped CDR that is contained in segmentation result 

(if segmentation result exists at all)
 Output of minimum and maximum values for beamformer kurtosis
 Changed “regularized” to “normalized” in beamformer output
 Standard brain can now be used for source analysis
 Bug fixes

For Curry 7.0.6:
 For fixed/regional dipoles, now largest value is positive, not integral
 After a moving dipole fit, 3D cursor now moves to dipole for current display timepoint
 For dipole simulation, additional metrics (such as ellipsoid containment) are not 

computed any more
 Bug fixes

For Curry 7.0.5:
 Calculation of scan currents (beamformer) initially switched off to save memory
 Create output text for both scans and scan dipoles/currents
 Improved stability of sLORETA when the norm p is equal to 1
 Improved determination of lambda when norm p < 2
 Improved computation times for Minimum Norm and eLORETA when norm p < 2
 Improved output text for situation where lambda is zero or infinity
 Bug fixes

For Curry 7.0.4:
 Source results now include event name or data file name in their description
 CDR dipoles and coherence now include type in their description
 Scan type is now switched to “Off” after exporting lead field as a file
 Speedup for moving dipole fits with BEM head models
 Source surface, BEM model can now be stored in study parameters
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 Option to let MATLAB compute the lead field, with “Infinite homogeneous” as 
example

 Scan and Scan CDR meshes can now be inflated
 Decreased resolution of “Standard Brain” for easier use as source locations
 Standard Skin and Skull do not appear as source location options any more
 Bug fixes

For Curry 7.0.3:
 Bug fixes

For Curry 7.0.2:
 None

For Curry 7.0:
 Frequency domain source analysis 
 ICA-based dipole fits
 PCA/ICA-based current density analysis
 eLORETA current density method
 sLORETA reformulated as linear method
 Choice of overlays, markers, segmentation for fMRI weighting
 Option to exclude stop markers from source locations
 Smart un-plot of underlying source location surface
 Source Coherence
 MATLAB plugin support for source analysis

2.8. Image Data Import

 Improved axis orientation detection from NifTi files
 Improved estimation of skin segmentation threshold
 Improved output of series characteristics
 For NifTi signed short/int images, negative are ignored per default (can be changed 

by enabling “Signed”)
 For image data folders, number of slices and slice distance are now considered 

when determining zoom factor
 Fixed a bug where Brainvoyager .vmp files (version 1) were not correctly detected

For Curry 7.0.11:
 Support for signed NifTi files 
 Support for rescale intercept/slope parameters from DICOM and NifTi files. 
 Display of intensity values based on rescale intercept/slope parameters in popup 

information window
 Create meaningful Talairach coordinates if MS landmark is lower than AC
 Bug fixes

For Curry 7.0.10:
 Improved auto-detection of white matter threshold 
 Unsuccessful reading of hidden files is now ignored when scanning for image data 

parameters
 Axial view is now the 2nd display choice for entering AC and PC; Coronal is 3rd choice 
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For Curry 7.0.9:
 Allow to discriminate DICOM series by UID, not only by series number
 Support for DICOM JPEG RGB images
 Support for Brainvoyager .vmr version 4 and 6 format
 Autodetect Image Data modality from Brainvoyager files
 Reuse landmarks from first image data set for Brainvoyager .vmp files
 Changed related output from bold to normal font if image parameters do not exist
 SPM header contents are not logged any more during autodetection

For Curry 7.0.8:
 Warning that landmark autodetection needs to be redone after image parameter 

change
 Bug Fixes

For Curry 7.0.7:
 Special icon to identify 3D DICOM files in an image data folder. Such files should be 

loaded as single files to be correctly read
 Image data zoom factor initialization now also accounts for vertical image dimensions
 Bug fixes

For Curry 7.0.6:
 Opening image data now triggers autodetection to determine the original extension
 When specifying the midsagittal (MS) landmark, the second view option is now the 

coronal view
 Bug fixes

For Curry 7.0.5:
 Landmarks below a surface are now shown as stippled
 Improved handling of DICOM folders with number of frames equal to 1 in each file
 Improved convergence and stability of landmark autodetection (co-registration)
 DICOM files with incorrect (same) image numbers are now sorted by image position, 

if possible, before defaulting to sorting by file name
 Bug fixes

For Curry 7.0.4:
 DICOM images with non-existent dimensions are now ignored
 fMRI images are now automatically displayed with a hot color scale
 Bug fixes

For Curry 7.0.3:
 Added support for CTF .mri file format
 Added support for reading landmark locations from image data header for CTF .mri 

and .svl (SAM) file formats. As a result, .svl files are now automatically co-registered
 Added axis orientation autodetection from nifti files
 Added a “Modality” (MRI, CT, etc.) parameter to the import user interface
 Improved detection of wrong DICOM group length tags to avoid read errors for 

incorrect DICOM files. As a fallback, group is not skipped but all tags in that group 
are read
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 When trying to load an image data set with titled slices (not stacked perpendicularly) 
a warning now pops up

 Changed the default “intensity” scaling for floating-point and 8-bit image data files to 
100%

 Made “Skip Talairach Definition” the default
 Changed text in landmark autodetection popup window to make it easier to 

understand
 Use a false color scale for .svl (SAM) images
 When using built-in image data, an image parameter file is created in the user’s 

Application Data folder and, if present, loaded. Editing this parameter file makes it 
possible to change properties of built-in image data

 Added the option to control (by editing the global parameters file), which built-in MRI 
to use per default. This makes it possible to always use the Asian MRI without having
to explicitly switch for each new study

 Added an option the the Troubleshooting section of Edit > Options that disables 
“Move Unknown Labels to Others”

 Bug fixes

For Curry 7.0.2:
 None

For Curry 7.0:
 Digital Photography (2D image) support
 Pediatric averaged MRI built-in
 Asian averaged MRI built-in
 Individual MRI built-in
 JPEG, BMP, PNG, GIF, TIFF image data support
 RGB image data support
 DTI Fractional Anisotropy (FA) support
 Continuous support for changed and new file formats

2.9. Image Processing 

 Option to include Localize in saved Image Data even if it's not currently displayed in 
3D View

 CDRs and Scans displayed as symbols are now always shown solid, if 2D Distance 
is enabled

 Skin color is now only assigned to surfaces whose volume is larger than 2700ml 
(was: 2000ml)

 Fixed a bug where image intensity values as displayed in the user interface may in 
some cases be limited to half the actual range

 Fixed a bug where, after stopping BEM/FEM creation, subsequent import overlay 
does nothing

 Fixed a bug where, when saving image data, if image data have non-cubic voxels 
and coordinate system is "Raw", Stop/Pass marker locations in saved image data 
are wrong

For Curry 7.0.11:
 Small disconnected meshes are detected and deleted after mesh repair 
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 Option to cancel if creating an object (such as points) would overwrite the most 
recently created one.

 Lowermost slice is only extended as far as accessible by segmentation
 When converting triangle mesh to stop markers, use currently displayed geometry 

(standard/inflated)
 Display Talairach slice labels in corners of Talairach grid
 Added (0010,0062) and (0010,0063) DICOM tags (Patient information de-

identification) when saving image data in DICOM format
 Changed DICOM Position Reference Indicator to SLIDE_CORNER when saving 

image data in DICOM format
 Added <,>,= symbols for left-right intensity comparisons in popup information window
 Added intensities to MIP and Histogram popup information windows
 For image data histogram maximum calculation, disregard the last and the single 

largest entry
 Bug fixes

For Curry 7.0.10:
 Option to display a labeled Talairach grid in orthogonal views
 Option to change cursor size 
 Changed default text color from dark gray to light gray
 For img/hdr image data files, voxel intensities are now scaled according to 

glmin/glmax and displayed in tooltip information window
 Improved preparation of inflation in cortical meshing
 If debugging and marker editing are both active, don't display debug information in 

orthogonal views
 When “Save Movie as (avi)”, cursor location now changes according to dipole 

location and cursor is included in the movie (unless switched off via Options panel)
 Bug Fixes 

For Curry 7.0.9:
 Raw Slice orientation is now the default when saving image data
 Ctrl-click now appends cursor location to Localize
 Bug Fixes

For Curry 7.0.8:
 Option to display Points
 Support for Electrode, Localize, Point, Landmark label display
 Support for new “2D Visibility” parameter for Dipoles, Localize, Points, Landmarks, as

well as Current, Scan, Leadfields (in Symbol mode) that controls out-of-plane 
visibility

 Support for "used for fit" option when displaying electrodes
 Improved default symbol size for result display
 Option to change symbol size for result display
 Option to include dipole, Localize, CDR, scan orientations when saving image data
 Bug Fixes

For Curry 7.0.7:
 Image Data saved as DICOM files with source results now include result names and 

clipping values
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 Cortical lamina are not auto-displayed after cortex creation any more
 Bug fixes

For Curry 7.0.6:
 Creation of cortical lamina along with cortical triangle mesh in BEM Geometry for 

improved brain visualization
 When synchronizing studies, 3D cursor is now also synchronized
 Pinch-to-zoom support in orthogonal views
 When setting the reference, information about segmented volume is now written to 

Output window, including mean intensity of segmented volume
 Improved default voxel mesh display settings for DTI data
 Added a tooltip window for the “Show segmentation results” toolbar button
 Bug fixes

For Curry 7.0.5:
 Electrodes are now colored according to their voltages if a color scale is selected
 Option to export cursor location to Localize by CTRL-clicking in an Image Data view
 Option to close parent study when saving a file and opening it as a new study is 

initiated by macro, in order to keep number of open studies low
 Bug fixes

For Curry 7.0.4:
 Automatic BEM geometry setup now prepares inflation and export for BEM surfaces
 Bug fixes

For Curry 7.0.3:
 Electrode label names are now displayed in image data tooltips
 Intensity differences between left and right hemisphere are now shown in the tooltip
 Added text at the top of the image data slice displays that indicates if Marker editing 

is active in that particular view
 When using the mouse wheel in the Segmentation Result display, thresholds are 

changed and a new segmentation using the changed threshold starts
 In the segmentation Preview display, made “Omit Stop Markers” the default
 Added a Segmentation Result sub-menu to the slice display context menu to make 

more options available
 Option to specify labels for skin and cortex in BEM geometry setup
 When creating a BEM model with an already existing name, [1] etc is automatically 

appended
 When voxel points are created based on (RGB) DTI FA data for 3D display, ellipsoids

now scale with the overall voxel intensity, making low-intensity ellipsoids less visible
 When “Thresholded Image Data” is added to the display and the dataset in question 

is an RGB (color) dataset, it is now displayed in color
 When “Thresholded Image Data” is added to the display and the dataset in question 

is interpolated, it is now displayed as interpolated
 Removed Maximize button in histogram slider display
 Changed the cortex threshold for built-in dataset “colin27” to 120
 When starting a segmentation, the cursor location does not change anymore to 

reflect the actually used seedpoint. This change was necessary to enable correct 
macro recording of segmentation
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 Option to include Scan results when saving image data
 Exported DICOM files are now fully standard compliant
 When exporting slices as a movie file and writing a raw format file instead of an avi 

file, an image parameter file is now written that allows to open the “movie” file as an 
RGB image dataset in Curry

 Bug fixes

For Curry 7.0.2:
 Increased maximum possible symbol size when including dipoles/electrodes/Localize

locations in saved image data
 Option to include Currents in saved image data
 Option to not include image intensities in saved image data (makes it possible to 

save results only)
 Added an Advanced button in the BEM Geometry setup parameters
 Added the option to create a raw 3-D color image data set by saving slices from the 

hardcopy menu and selecting “Raw” as the file type. Such a 3-D color image can 
contain results, atlas data, etc.

 Changed default of this symbol size to 2 which is a 3-D crosshair

For Curry 7.0:
 Result display in MIP view
 ECoG/MEG BEM creation
 Triangle mesh merging
 Improved voxel mesh creation (no segmentation necessary)
 DTI FA visualization as voxel points (ellipsoids)
 Image data averaging
 MATLAB plugin support for image processing

2.10. 3D View

 Prevent drawing of confidence ellipsoids for clipped dipole symbols in OpenGL mode
 Fixed a bug that lead to a crash when plotting a surface, BEM, or FEM which has 

previously been deleted from memory but still exists on disk

For Curry 7.0.11:
 Bug fixes
 Removed (unsupported) cutplane options from Properties of CDRs, Scans, and 

Leadfields

For Curry 7.0.10:
 Option to display current density symbols with uniform size
 Performance improvements for surface inflation 
 Bug Fixes

For Curry 7.0.9:
 Clicking on a transparent object now selects the underlying object
 Bug Fixes

For Curry 7.0.8:
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 New “2D Visibility” parameter for Dipoles, Localize, Points, Landmarks, as well as 
Current, Scan, Leadfields (in Symbol mode) that controls out-of-plane visibility in 
Image Data

 Display support for source coherences calculated in the frequency domain
 For Localize and Points, the “selected” item is displayed in highlight color
 Bug Fixes

For Curry 7.0.7:
 Time cursor's units are now “sec.” for times larger than 10 sec.
 Landmarks are not automatically displayed any more
 Transparency for objects can now be modified when “Compatibility Mode” is active
 CDR dipoles are now clipped with respect to (largest) strength, not deviation
 If a crash is detected while displaying transparent objects, the program will enable 

“Compatibility Mode” for next restart
 Coherence arcs, dipoles, and CDRs can now be displayed in stereoscopic mode
 Selection of complete source and kept result folders for display can now be recorded 

and replayed by macro
 Bug fixes

For Curry 7.0.6:
 Camera settings (perspective) are now stored in study parameters
 Cutplanes' manual offset is now inverted in "flip" mode
 Doubleclicking a dipole in a cluster created by scanning through epochs now 

switches to corresponding epoch in Functional Data
 Dipole ellipsoids cannot be selected any more (too confusing for clusters)
 When transparent maps and contour lines are overlaid, lines are opaque
 Improved resolution for contour lines
 Bug fixes

For Curry 7.0.5:
 Coils' label color can now be adjusted
 Added “time-independent” nets (e.g. beamformer metric)
 Sensor coherence: “source” and “sink” channel labels are now displayed in tooltip
 Default cutplane "through" mode is now "Origin"
 Dipole symbol increment is now 1 mm
 "Z rotation" can now be performed with Ctrl + mouse wheel
 Removed "ghost" images when creating rotation movies
 Bug fixes

For Curry 7.0.4:
 Added manual scaling for Maps (and Electroldes)
 Viewing direction (and zoom) can now be controlled via macro
 Removed anti-aliasing artifacts with 2D objects
 Bug fixes

For Curry 7.0.3:
 A standard skin, skull, and brain are now always available for display. These surfaces

are scaled as to best match the electrodes. As a consequence, surfaces 98..100 (file 
extensions s97..99) are not available anymore
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 Points are now offered for display even if they are not loaded yet
 Option to only show coherence arrows for certain regions
 Output number of coherence arrows displayed (total and per region)
 New dipole color type “Auto” which switches between “Time” and “Dipole index” 

depending on dipole type and number of samples
 Scan dipoles now have a Cyan..Blue colorscale instead of monochrome Cyan in 

order to benefit from the new “Auto” dipole color type
 Changed the default color of Localize and Points labels to white
 Changed the default size of Localize symbols to 5mm
 Removed the “Rotate and play movie (eternal)” context menu option as it distracted 

from the more important “Play movie (eternal)” option in the View menu
 Added an option in the Troubleshooting section of Edit > Options to enable anti-

aliasing. This option may be overridden by a respective setting in the graphics driver 
control panel and will then have no effect. Anti-aliasing will only work if supported by 
the graphics card and if no transparent objects are visible

 Added "electrode" color scale
 Added “power frequency”, "averaged", and "normalized" 3D maps
 Added units for "electrode" tooltips
 Added cutplanes for electrodes and coils
 Bug fixes

For Curry 7.0.2:
 Line width of confidence ellipsoids can now be adjusted
 Renamed “Color Coding” in the statistics display parameters to “Display”
 Changed minimum inflation required for offering to save inflations as avi from 1 to 3
 Bug fixes

For Curry 7.0:
 Option to load surfaces etc. directly from 3D View 
 Digital Photography (2D image) display
 Coherence display
 Projected electrode display
 Voltage-colored electrode display
 Voltage and field maps display
 Improved location rendering (shapes, labels, color scales)
 Full-screen 3D Mode (experimental)

2.11. Localize

 Fixed a bug where “Import Coils” assigned incorrect MEG gradiometer labels

For Curry 7.0.11:
 Option to load locations from rs3 files
 Improved setup of grids and strips with small inter-electrode distances
 Bug fixes

For Curry 7.0.10:
 "Save and use as digitizer file" now works with read-only databases
 An error message is displayed when changing sensor location is not possible
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 Macro commands for stepping through Localize list and setting cursor accordingly
 Arrow buttons in “Change Locations” are now disabled if no Localize locations exist
 Bug Fixes

For Curry 7.0.9:
 Localize list now allows to select and review entries in Show mode
 New 'Delete All Entries' button below localize list
 Restore original entries after failed grid update or create
 Enabled Undo when editing the Localize list
 Switch Localize list to append mode after grid setup
 Bug Fixes

For Curry 7.0.8:
 Option to create depth (needle) electrodes in Grid Setup
 Option to load Elekta .dip files
 Mean distance, area, and volume are now computed when creating Points
 Shorter default labels for grids, strips, depth electrodes
 Support for zero dipole strength in Dipole Simulation
 Bug Fixes

For Curry 7.0.7:
 Bug fixes

For Curry 7.0.6:
 Support for location files with “label, x, y, z” column ordering
 Support for location files with [m] and [cm] units
 Remember selected file format used for saving
 Bug fixes

For Curry 7.0.5:
 Option to remove Localize locations outside of segmentation result
 Option to cancel out of 10-20 system creation
 Improved import of landmark .pom files created while reading .fif format files

For Curry 7.0.4:
 Localize labels are now displayed as numbers only (“##” instead of “Entry ##”)

For Curry 7.0.3:
 Localize labels are now displayed as numbers only (“##” instead of “Entry ##”)
 Improved the workflow for “Adjust Sensor Positions”: there are no file selection and 

no data import tool popup windows any more, and less questions appear. 
Furthermore, sensors are automatically displayed in 3D View and the display 
switches to 3D View (6)

 Added macro support to the Localize 3D View display
 Automatic 10-20 system setup now creates all 160 electrode positions from the 10-5 

electrode system
 Automatic 10-20 system setup now uses Iz label instead of INI and I1/2 labels 

instead of O9/10
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 Automatic 10-20 setup is now more robust and proceeds even if some electrode 
locations cannot be determined

 When saving locations as digitizer file and there is more than one electric channel 
group, user is asked which channel group to use these locations for

 New option to “Import Sensor Landmarks”. The existing “Import Landmarks” was 
renamed to “Import Image Data Landmarks”

 New option to “Make Locations Symmetric”. This can be used to convert an 
individual electrode layout into a generic one

 After dragging a location, edit mode switches back to append mode
 List of localize locations now auto-scrolls to the active location
 Default grid electrode labels are now consecutively numbered; do not contain 

row/column any more
 When trying to create a grid on a cortical surface (as opposed to the smoothed 

surface of the brain), a warning now appears
 In the 3D View display, the catch radius that determines if an existing location shall 

be moved or a new location shall be added is now expressed as screen pixels not as
mm any more. This makes it easier to add nearby locations when the display is 
magnified

For Curry 7.0.2:
 Option to relabel Localize locations based on nearest locations stored as Points
 Bug fixes

For Curry 7.0:
 ECoG grid placement planning
 Dipole Simulation UI
 Integration of Localize functionality into 3D View
 Undo support

2.12. Results

 Fixed a bug where Talairach coordinates could not be selected as the coordinate 
system

 Fixed a bug where MATLAB CDR dipole export did not work

For Curry 7.0.11:
 Improved diagnostic information in error message if number of samples of statistics 

input data doesn't match
 Statistics module doesn’t compute length of significant segments in frequency case, 

nor in single-sample or collapsed-samples case, as this would not be meaningful
 Bug fixes

For Curry 7.0.10:
 Delimiters between numbers and units are now a half-space wide
 Bug Fixes

For Curry 7.0.9:
 none

For Curry 7.0.8:
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 Use ellipsis for display of long filenames in Results
 Improved error message when Statistics result grid autofill fails
 Bug Fixes

For Curry 7.0.7:
 Statistics module now available with “Basic Source and Image Processing” license
 Improved log output of insignificant segments in Statistics
 Increased the maximum number of Points from 10 to 30
 Names for Kept Results which had been edited (e.g. in 3D View) are used as 

suggestions for filenames and retained through saving and loading result files
 Bug fixes

For Curry 7.0.6:
 When saving results, a meaningful and available filename is now suggested
 Statistics can now access individual epochs when “x Epochs” is not checked
 Statistics can now compute consistency tests for only one condition
 Shortcut key Ctrl+Shift+A for appending results
 Append results can now append more different dipole types
 Bug fixes

For Curry 7.0.5:
 Option to export Scan results as SPM-format files
 Bug fixes

For Curry 7.0.4:
 Added Excel and MATLAB export for Scan results
 m-files created when saving results now have MATLAB-compatible file names
 improved m-file for saved dipole results to always display visible dipole symbols
 Statistics data sources adjusted in grid can now be stored in study parameters
 Statistics data source grid now displays epoch names not just numbers
 Changed colors for „Keep Results” to improve contrast; no gray colors
 Bug fixes

For Curry 7.0.3:
 Time range and Ellipsoid display mode toolbar buttons now work faster
 A progress bar appears now when a study is closed and unsaved results are written 

to disk
 Bug fixes

For Curry 7.0.2:
 Option to merge several dipole results into one as an alternative to “Keep Results”
 Increased the maximum number of cells in the statistics data grid to 256
 Removed the option to “Mark Results” in statistics because now a gray backdrop is 

used for insignificant latencies
 When creating averages in statistics, the grand average is now created as well
 Improved the wording for output of significant segments in statistics
 Option to expand analysis timerange to whole data window from the statistics module
 Added Excel export for statistics results
 Added Excel export for Points
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 Bug fixes

For Curry 7.0:
 Statistics module
 MATLAB plugin support for statistics calculation

2.13. Workflow

 None

For Curry 7.0.11:
 none

For Curry 7.0.10:
 Removed unusable context menu from workflow bar
 Bug Fixes

For Curry 7.0.9:
 none 

For Curry 7.0.8:
 none 

For Curry 7.0.7:
 none 

For Curry 7.0.6:
 Add Image Data workflow item is now removed while study is locked during in-place 

averaging.

For Curry 7.0.5:
 New Signal Processing workflow item for Statistics

For Curry 7.0.4:
 “<CAR> referencing” has now a green checkmark

For Curry 7.0.3:
 Added digitizer item

For Curry 7.0.2:
 Added the state (in parentheses) to several workflow labels in the Signal Processing 

section
 Hide items that apply to epoched data in non-epoched mode and vice versa

For Curry 7.0:
 Macro-enabled workflow sidebar

2.14. Automation

 None
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For Curry 7.0.11:
 Bug fixes

For Curry 7.0.10:
 Prevent playing parent study's macro files for derived studies
 When adding text to Report or Output window via macro, shortcuts such as *SU, *ST

etc are supported
 New self-expanding keyword *GR which has same meaning as *EX
 When macro is automatically started when opening a study, beginning and end of 

macro execution are now logged to Output window

For Curry 7.0.9:
 Support for execution of chained macros in folders other than the Macros folder
 Bug Fixes

For Currry 7.0.8:
 Option to add macro to study via right-click
 Reset mode in Playback Options reverts to “Nothing” when software starts
 Bug Fixes

For Curry 7.0.7:
 A popup message is now displayed when single-stepping through a macro has 

reached the end of the macro
 Option to single-step when user is asked to execute a Study macro
 Maximize button presses in Data Display are now recorded to macro
 Bug fixes

For Curry 7.0.6:
 The currently selected “3D object" is now recorded
 Temporary macros (via database or “Select and Play”) are now displayed first
 Improved temporary macro icon
 File list view mode (list/details) is now remembered across sessions
 New option to append regional coherence table to a text file
 Bug fixes

For Curry 7.0.5:
 Option to close a study from a macro
 Option to edit, erase, rename macros in non-standard folders
 Changed macro “Record” toolbar button tooltip to “Record Macro (Append)” in order 

to make clear that existing macros are not overwritten by pressing Record
 Bug fixes

For Curry 7.0.4:
 When saving a file to a non-existent folder, folder is automatically created
 New toolbar button to run a macro file from any folder
 Macro is now paused not stopped when study changes
 Macro filenames can now be edited (files will be renamed)
 Macros that automatically run when a study is opened are now called “study macros”
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 *DB is now expanded to be the path of the database archive
 New macro function to delete a file
 Text and button labels for Macro pause dialog revised
 Explanation tooltip for “Reset” in macro dialog
 Bug fixes

For Curry 7.0.3:
 Parameter panel switches are now recorded to a macro and can also be replayed
 When running a macro on selected database entries, a depth selection windows now

appears. This makes it possible to restrict macro execution to e.g. only the children 
or grandchildren of selected  studies

 Option to access several recent popup window / banner texts
 The toolbar button that used to bring up the “Pause” popup now creates a “Pause or 

Continue” popup because this is the more frequently needed one. The “Pause” 
popup is still accessible from the “Tools” toolbar button

 Option to actually pause recording after recording a “Pause or Continue” Popup. New
text to explain what the respectice buttons (Ok, Pause, Cancel) actually do

 Filenames in macro files may now be edited to contain the same wildcards that are 
also used for the “Save As” filename. This allows to create macros that employ more 
specific result file naming schemes

 Made sure that the scrollbar that appears at the bottom of the macro file display 
when it is in “List View” mode is visible even if part of the macro UI is hidden because
of insufficient vertical space

 File name feedback for the “Save As” filename now appears below the edit field
 Improved detection of <ESC> key presses to stop macro replay. More detailed 

feedback mentioning that results from last processing step might be invalid only if this
might really be the case

 Bug fixes

For Curry 7.0.2:
 None

For Curry 7.0:
 Macro recorder
 Batch functionality (run macro on selected files)
 Database automation (run macro on selected studies)

2.15. Report

 None

For Curry 7.0.11:
 Bug fixes

For Curry 7.0.10:
 When adding text to Report via macro, shortcuts such as *SU, *ST etc are supported

For Curry 7.0.9:
 none 
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For Curry 7.0.8:
 none 

For Curry 7.0.7:
 none 

For Curry 7.0.6:
 Bug fixes

For Curry 7.0.5:
 Bug fixes

For Curry 7.0.4:
 none

For Curry 7.0.3:
 Text is now copied to the Report in Unicode, preserving special symbols
 Bug fixes

For Curry 7.0.2:
 None

For Curry 7.0:
 Adjustable hardcopy size

2.16. Acquisition

 Added SynampsRT and Neuvo amplifier configurations for new Net caps (32, 64, 
128, 256)

 Autoscale button now auto-scales entire page instead of individual channels
 Grael: Added support for bipolar channel impedances
 Disabled option to start impedance check from button on Synamps headbox
 Improved Split-View display
 Fixed an issue with average waveforms sometimes not being displayed after loading 

cfg file before starting an acquisition
 Fixed an occasional crash when closing Curry while the NuAmps is in impedance 

mode

For Curry 7.0.11:
 Added an option to convert recordings into other file formats from within the 

Acquisition module (no Signal Processing license required)
 Added amplifier configurations for Quik-Cap Net (32, 64, 128 and 256 channels)
 Added Grael PSG and Grael EEG support to Curry Express package
 Added Cedrus Stimtracker support for NuAmps amplifiers
 Added new verision of Grael configuration tool
 Added impedance check on positive and negative bipolar channels for Grael 

amplifiers
 Added configuration for MicroMagLink 64 channel cap
 Added an option to start and initialize the MATLAB interface before starting an 

acquisition
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 MATLAB plugins now receive channel labels and trigger events
 Bug fixes

For Curry 7.0.10:
 Event codes and sampling rate are now passed to MATLAB, when using the online 

MATLAB interface
 Show the delay caused by artifact reduction in the Advanced section of the Artifact 

Reduction dialog
 Improved performance when “out-of-realtime-severity” is low (this mostly affects 

MAGLINK recordings)
 Improved delay of displayed artifact reduced data
 Improved performance saving online averages
 For channels with unknown labels, compute 2D positions from 3D position in 

amplifier configuration
 Removed “Show Clock” feature from online video dialog
 Changed fonts used for channel labels and view description
 Added a mode to disable video preview during acquisition (needed for PointGrey 

cameras)
 Changed digitizer 'Reference' electrode label to 'Ref'
 Added StimTracker event types to Average Configuration and Conditions dialog
 Added a plausibility check to the ranges in Grael amplifier configurations
 Bug Fixes

For Curry 7.0.9:
 Added support for Siesta amplifier
 Add an option to use an individual channel order for digitization in amplifier 

configuration xml files
 Added suppport for non-unique labels in an Amplifier Configuration (non-unique 

labels are shown and notified about when saving)
 NDI digitizer: Added tool definitions for ANT tools NT-115 and NT-144
 NDI digitizer: Don't play warning sounds after all electrodes have been measured
 Improved the way the time cursor are set at the edges of the waveform area
 Improved display of Bad Blocks during acquisition
 Changed the Matlab interface to only receive non-overlapping data parts during 

acquisition
 Color and line width settings are now part of parameter files (.cfg)
 Bug Fixes

For Curry 7.0.8:
 Added support for Grael EEG amplifier
 Added support for Compumedics Neuroscan Photic Stimulator device
 Improved the accuracy of events received from Grael amplifiers
 Improved automatic position plot window layout (especially when 2D positions don't 

form a plane)
 Extended list of bipolar channel labels recognized in NuAmps configurations
 Bug Fixes

For Curry 7.0.7:
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 New NuAmps device driver that adds support for Win7/8 64 bit systems and 
improves the performance on Win7/8 32 bit systems. When applying the 7.0.7 
upgrade, these drivers are copied to the installation folder but not automatically 
installed. When doing a full install, the new drivers are installed when requested

 Synamps2/RT now supports individual internal gains per headbox (useful for multi-
subject recordings, otherwise it's not adviced to use headboxes with different gains 
on the same system unit)

 Added support for Cedrus Stimtracker device
 Added Hi-Level channel support for Neuvo devices
 Added a safety feature that prevents Curry from becoming unresponsive in case of a 

prozessor overload during acquisition
 Added an Event Log window to the Advanced section of the Averages dialog
 Option to display a Synamps2 background in the Device Configuration dialog
 Option to taper artifact reduced data segments
 Option to mark the onset, offset or both of response events (or certain stimulus 

events when using the Cedrus Stimtracker)
 New example MATLAB file that creates a butterfly plot of channel waveforms
 Improved stability and accuracy of impedance measurement on NuAmps devices
 Improved performance of Curry during digitization
 Improved 'Auto Layout' option for layouts with three averages
 Improved performance of online data processing
 Changed highlight color of channel windows during digitization
 Changed displayed AC HP filter frequency to 0.05Hz in Amplifier Configuration dialog
 Limit for pre-recording time is now depending on the actual buffer size (maximum 

time displayed in tooltip window)
 Atomatically add 'Others' channels to new Reorder Montages
 Show impedance values with 2 decimals when they get below 1 kOhm
 Trigger setting parameters are now stored and reapplied automatically
 Removed Hi-Level channels from Synamps2/RT impedance test
 Display Filter Sets 1 – 3 now apply different band filters per default
 Bug fixes

For Curry 7.0.6:
 Added Support for Cedrus StimTracker
 Added automatic “Split File” option that creates new files after exceeding a definable 

file size
 Added “Ripples” and “Fast Ripples” to filter presets
 Added macro actions for amplifier control buttons
 Added 200ms ticks to waveform display
 Added configuration for SynampsRT MicroMagLink 64 channel cap
 Automatically split recordings when file systems maximum file size has been reached
 Added a security feature that continues recording to a default folder when writing to 

the current destination fails (for example when losing connection to a network folder)
 Added hidden option to change the software aliasing filter properties for SynampsRT 

recordings (ask Curry Helpdesk for details)
 Store name of used configuration in recorded file
 Improved performance of filtering short data segments
 Improved performance of waveform drawing and position plot
 Improved stability of search routine for network amplifiers
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 Improved event conditions checking for timerange (less waiting time)
 Improved SynampsRT/2 impedance calculation (much less prone to external noise) 

and inject test signal in phase on banks of 32 channels
 Revised NuAmps Impedance calculation method (more accurate estimation of GND 

impedance)
 Filter out NuAmps false “r15” events
 Bug fixes

For Curry 7.0.5:
 Added impedance options to temporarily disable bipolar or monopolar channels 

which greatly increases update rate of impedance values of monopolar channels 
(Synamps2/RT only)

 Enabled response bits on NuAmps trigger channel
 Added 'All' and 'Global' options to Artifact Reduction Dialog
 Added 'Detrend' option to Artifact Reduction Dialog (improves fMRI artifact reduction 

in certain cases)
 Added 'Plausibility Check' option to Digitizer Dialog
 Added option to add comments to acquired file
 Added simulated impedance test for Amplifier-Simulator
 Added active view information to Filter Parameters-, Options- and Frequency 

Domain-Dialog
 Added debugging output when using Video
 Use mouse wheel to change upper impedance threshold in impedance display
 Use +/- keys to scale waveforms
 Use left/right arrow keys to move time cursor
 Store “Sync” option when saving parameters
 Store epoch info with saved averages
 Apply baseline when using "unfiltered data" for artifact reduction
 New FSP default values
 Always ask to save changes when changing read only configurations, montages or 

placements
 'Others' channels are automatically added to study placement of the current device 

and thus are directly available in the Montage Editor
 Removed obsolete Montage color selector from Colors Dialog
 Updated Polhemus PDI
 Improved delay of data display when Artifact reduction is enabled
 Improved layout of channels in butterfly plot when there are 'Others' or MGFP
 Improved digitizer gesture detection when digitizing landmarks
 Modified event status indicator (accepted events no longer carry a green indicator)
 Modified default annotations
 Bug fixes

For Curry 7.0.4:
 Added NDI Polaris and Polhemus FasTrak III digitizer support
 Improved setup procedure and error handling for Online Video
 More accurate video synchronization
 Option to rotate and scale electrodes in the Sensor Placement dialog
 Added background brain images to Sensor Placement dialog
 Option to apply a “Constant Baseline Correction”
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 Option to use a Linear Derivation File
 Option to “Optimize Position Plot Layout” and “Enlarge Window Size And Optimize 

Layout” to Position Plot views
 Added Numpad accelerators for creating annotations
 Added <All> token to Conditions dialog
 Added 'Help' button to Conditions dialog
 Added possibility to measure position of Reference electrode
 Added more visual feedback to impedance test
 Added “Allow Impedance Test” option to Amplifier Configurations to prevent 

impedance tests during intracranial recordings
 Option to handle bipolar channels like monopolar channels
 Option to add positions to Amplifier Configurations
 Added Hi-Level channel scaling factor setting to Synamps Amplifier Configuration
 Added Hi-Level voltage output to Synamps Amplifier Configuration
 Added NuAmps 36 channel cap configuration
 Added option to define the number of blocks per second sent by Synamps2/RT
 Added option to chose between ScanLT and NuAmps channel mapping
 Added info about used amplifier to report and recorded files
 Option to revert to original electrode positions after digitization
 Added speech recognition for Polaris Vicra digitizer
 Added several debugging outputs (when Debugging is on) for troubleshooting
 Added ScanLT 40 channel configuration
 Added several cap configurations for Neuvo
 Amplifier Hardware info (serial- and partnumbers, firmware revision) from NuAmps 

and Synamps2/RT amplifiers are stored in the recorded file
 Exclude “Others” channels from auto-deselect with Bad Impedances
 Show labels in Bad Impedances message box.
 Add break events when recording pauses
 Force stopping digitization of an electrode after 50 collected points
 Polhemus Digitizer now also works with just one additional reference coil
 Automatically create a .pom file when non-eeg positions have been digitized
 New digitizer sounds
 Added advanced AUTO_MOVE_NUMBERED_CHANNELS_TO_EEG option to 

SessionDefaults.cfg
 Removed obsolete USB/Serial Port settings from Digitizer dialog
 Automatically move numbered channels to EEG group only when majority of 

channels already are EEG channels
 Improved usability of the Montage Editor
 Improved initial layout of Position Plot views
 Improved layout of impedance view for better readability
 Improved bar-graph and switching between time and frequency domain
 Improved memory efficiency of Online Artifact Reduction
 More accurate drawing of online waveforms and event blocks
 DF/DN/IF/IN filename shortcuts are not offered for data file name any more
 Bug fixes

For Curry 7.0.3:
 Digitizer module with Polhemus Fastrak support
 Video module for recording synchronized EEG and video
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 “Auto-detect bipolar channels” functionality for NuAmps amplifiers
 Load positions from pom file for running acquisition
 More precise timing of drawing ongoing data
 Added “Siesta PSG” configuration
 Amplifier configurations can store alternative labels and electrode positions
 Added positions and alternative labels to default “QuikCap 128” and “MagLink 128” 

configurations
 Increased performance of starting an acquisition
 SSC (Sub Sample Correction) for online artifact reduction
 Option to include/exclude “Others” channels from artifact reduction
 The "sparse" option now always displays all visible channels and never hides the 

MGFP
 Show "Acquisition running in another study" warning when pressing connect in a 

second study
 Changed default impedance threshold to 100 kOhm
 Modified workflow items for different licenses
 Modified range values for "64channels" configuration
 Average files are written as raw float .dat files (no longer .avg files)
 Added “Data/3DView” tab
 New amplifier control buttons
 Improved stability of “Quick impedance test” results
 Added “Open” button to montage editor (to import .xml and .mnt montage files)
 Added option to save montages in .mnt format
 Bug fixes

For Curry 7.0.2:
 Dialog for configuration of the trigger channel (also works with the simulator)
 Interleave and update options for online averaging
 Increased performance for averaging fast events
 Online PCA filtering (from file)
 Online MATLAB support
 Parameter to change size of online data buffer (not in UI)
 Parameter to change the artifact detection block size (not in UI)
 Added placement XMLs for caps: NuAmps 40, Quik-Cap 32,  Quik-Cap 64, Quik-Cap

128,  Quik-Cap 64 MagLink,  Quik-Cap 128 Maglink
 Added possibility to review from recorded file during acquisition
 Added algorithm to “Optimize Position Plot Layout”
 Online STFFT display
 Added dedicated “Disconnect” button
 Added Grael support
 +/- keys can be used to scale waveforms
 Display threshold lines during online artifact reduction
 Removed Siesta and Grael EEG from list of supported amplifiers
 Underline captions of overlaid averages and channels in the color of their waveforms
 Changed display of overlaid averages and differences
 “Save as” buttons in Editor dialogs allows to overwrite existing files
 Improved performance of impedance dialog
 Write dap/rs3 on disconnect to store impedance results after recording was stopped
 NuAmps automatically restores synch when packets were lost
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 “Re-Sync” button to manual re-synch the amplifier (for troubleshooting)
 Refractory period is set automatically when it is set to 0
 Bug fixes

For Curry 7.0:
 Acquiring EEG data with Synamps2, SynampsRT, Synamps Wireless, NuAmps (no 

64 bit Windows versions), Neuvo, Grail, Grail EEG, Siesta and E-Series
 Reviewing of live EEG Data in multiple individually configurable views
 Online Data Processing, including filtering, template matching and artifact reduction
 Analyzing data pages using all offline features of Curry during acquisition
 Create, store and review up to 100 averages
 Extensive average conditions

2.17. Miscellaneous

 TIFF hardcopy support
 Ensure all required modules stay loaded when Curry app is idle
 MRU files are now stored with fully qualified paths
 Added dongle protection for Neuromag reader
 Added support for cases where number of samples is -1 in LoadCurryDataFile.m 

which reads Curry files in MATLAB
 Fixed “invalid” dongle ID in crash reports
 Fixed a bug where Report contents coul not be saved after inserting an 

For Curry 7.0.11:
 Added vendor and CE information to Help > About
 LoadCurryDataFile.m now supports Curry 6 rs3 files, Curry 8 data files, improved 

error handling, improved support for MEG sensor locations, traces are now plotted in 
correct order

 Improved performance when loading Curry-format result files (surfaces, BEM 
models,etc)

 MATLAB plugins now work without having to edit Windows environment variables
 MATLAB Command Window Output is now also visible in the Curry Output window
 <Pause> key is now disabled per default (use <ESC> instead)
 Bug fixes

For Curry 7.0.10:
 Updated HASP dongle installers to latest version
 Montage selectors now sort montages based on whether they can be applied to a 

certain device group
 Automatically select new montage created by “Save As” on closing montage editor
 Improved automatic selection of a text-to-speech voice when preferred voice does 

not work
 Improved MATLAB-related error messages help user to make MATLAB interact with 

Curry 
 Installer adds firewall exceptions for network amplifier configuration tools
 Changed some text in Error Report Tool
 Error reports are now sent to curryreport@neuroscan.com
 Error report tool now uses own email program as fallback
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 Video window no allows zooming out beyond window borders
 Video window zoom can be done using the + / - keys
 In keyword-value files, unknown keywords and their values are now preserved for 

compatibility with earlier and later versions of Curry
 Bug Fixes

For Curry 7.0.9:
 Installer now with command line options for silent mode (/S), install path (/D=path), 

install type (/TYPE=0,1,2,3,4), and help (/?) 
 New Load.m file in Matlab folder that loads dat/dap/rs3 files into MATLAB and 

displays their waveforms
 Minor update for 3rd party math libraries
 Added an option to the Error Report Tool for browsing to error report folder 
 Parameter Pane switches to Functional Data when changing to Acq/FD views
 Replace forbidden filename-characters in filenames for montages, amplifier 

configurations and sensor placements
 Removed text about NuAmps driver only being installed on 32bit from the installer
 “Local folder” is only overridden if target folder has read and write permissions
 Bug Fixes

For Curry 7.0.8:
 Improved method to retrieve physical screen dimensions for accurate scaling
 Change file dialog folder presets based on paths of active study
 Closing a study is now logged to output window
 Name of software in Windows “Programs and Features” / “Add or remove Software” 

is now “Curry 7”
 Bug Fixes

For Curry 7.0.7:
 Replaced remaining “device(s)” output by “group(s)”
 Improved interoperability with Dropbox
 Fixed “tab order” in some parameter dialogs
 Improved method for determining the physical screen dimensions to ensure true 

scales
 Improved performance of Output window and log file for very large amounts of output

text. In such a case, the first line of the Output window may state that text has been 
clipped (which can still be found in the log file)

For Curry 7.0.6:
 Updated manuals, new Micro Maglink manual
 Added "Duplicate Study and Synchronize" functionality
 Added option to re-size video window to the size of the replayed video (Zoom 100%).
 Store video player settings in Study Parameter files
 Improved video file handling (consider overlapping video parts)
 Improved montage editor (remove empty montages; improved layout of current study

placement; improved handling when canceling out)
 Option to prevent escape/break/pause keys from stopping ongoing computations
 Now all registry setting are stored below a single folder (“Curry 7”)
 Ensure first visible view gets keyboard focus when opening studies without database
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 Bug fixes

For Curry 7.0.5:
 Option to disable Progress bar for troubleshooting
 Integer values in Curry parameter files can now be specified in hex (0xff) and octal 

(077) notation
 Improved compatibility with existing surfaces etc with active cutplanes
 Removed text output when writing dap/rs3 files (now debug output only)
 Bug fixes

For Curry 7.0.4:
 More detailed MATLAB-related error messages for easier m-file debugging
 Maximum number of threads increased to 32
 Maximum number of windows registry entry is set to 15000 for Vista and higher
 Curry now silently checks for updates every week
 Firewall exceptions for Curry, and Netbeacon created during install
 Ensure “query number of CPU cores” returns a positive value

For Curry 7.0.3:
 Updated Manuals
 New skin and cortex triangle meshes in Epileptic spike example data
 Option to install Polhemus Fastrak drivers from Start menu
 3D Space shortcut removed from Start menu
 Updated version of Sentinel LDK (HASP) dongle drivers
 If Curry is uninstalled while still running, files are now deleted upon reboot
 Names of files attached to helpdesk emails now start with “Curry”, so that they can 

easier be found on the desktop (which is where they are placed, so that the user can 
review them before sending the email)

 When creating a screenshot of the full data display (from the Edit menu), the tab 
headings are not included in the screenshot any more

 Option to run a Curry Express Edition as part of the NuAmps Express package
 Bug fixes

For Curry 7.0.2:
 Updated Manuals
 Running on a time-limited license does not add watermarks to screenshots any more
 Bug fixes

For Curry 7.0:
 New installer 
 New patch and hotfix technology
 New dongle technology (HASP)
 Registration / notification system (installation, up/downgrade)

3. SUMMARY OF KNOWN ISSUES 

These are the known issues with the current release:
 On some machines Curry can crash when playing movie (eternal). This seems to be 

a graphics driver issue.
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 On Windows 10, the Save File dialogs cannot be resized to a smaller size.

4. RECOMMENDATIONS FOR USERS IN THE MIDST OF A STUDY

If you are in the midst of a study and consider upgrading from an earlier 
version of Curry 7 to Curry 7.0.12, you are advised to do so.

5. OBTAINING SUPPORT, REPORTING PROBLEMS, AND REQUESTING 
FEATURES 

A procedure for obtaining support, reporting problems, or requesting 
features for this software release

5.1. Obtaining Support

Send an email to curry7help@neuroscan.com. 
This can be done via Help > Send Email to Helpdesk.

5.2. Reporting Problems

5.2.1. Curry Produces a Warning

If you are suspicious about a certain warning (error message):

 Edit > Options > Troubleshooting > Enable Debug Mode 
 Reproduce the error message as straightforward as possible
 In Output, right-click and select Open in Editor
 Save the log file and mail its contents to curry7help@neuroscan.com     

5.2.2. Curry Crashes

1. Edit > Options > Troubleshooting > Enable Debug Mode 
2. In Output, right-click and select Open File Location. 
3. An Explorer window opens.
4. Reproduce the crash as straightforward as possible
5. Use the Error Report Tool to submit a crash report. 

5.3. Requesting Features

Send an email to curry7help@neuroscan.com. 
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